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Microsoft Excel 2010 Step-by-Step Exercises 

PivotTables and PivotCharts: Exercise 1 

In this exercise you will learn how to: 

 Create a new PivotTable 
 Add fields to a PivotTable 
 Format and rename PivotTable fields 
 Rearrange PivotTable fields 
 Remove fields from a PivotTable 

Introduction 

These exercises are designed to help you learn how to build PivotTables and PivotCharts in 
Microsoft Excel 2010. They will guide you step-by-step through the various processes whilst at the 
same time explaining exactly what you are doing and why you are doing it. 

The exercises use the file CommodityShipments (PivotTables PivotCharts).xlsx which you can 
download from my web site at http://www.fontstuff.com/training/excel/stepbystep.htm 

To get the greatest benefit from the exercises you should work through the steps on your own 
computer using the sample file or files provided. You can work at your own pace. The steps are 
numbered so if you want to take a break you can make a note of how far you have got and start 
from the same place when you resume. Don’t forget to save your work if you close the file. 

Each step of the process is labelled in bold, for example, Step 3:. Follow the instructions exactly 
and do not leave any steps out. Occasionally you will see paragraphs labelled Try this:. These are 
optional actions which help illustrate particular features. You can choose to follow these instructions 
or not. This will not affect the progress of the exercise but will help you learn more about the topic. 
It is also important that you do not do anything else in the exercise workbook whilst performing 
the exercise, although you can work in other workbooks if you need to. 

Between the various steps you will find text and screenshots explaining and illustrating what is 
going on. You can choose to ignore this if you wish but you will learn more quickly if you 
understand what you are doing and why, so I recommend that you read them. 

Review the Data 

Step 1:  Start Excel then open the file Commodity Shipments (PivotTables and 
PivotCharts).xlsx and take a look at the different worksheets. 

The exercise file contains four worksheets: 

 Commodity Shipments This worksheet contains a copy of the data that you will be 
working with during the exercises. 

 Pivot Table On this worksheet there is a PivotTable based on the data on the first 
worksheet. There are also two Slicers. You will build a PivotTable just like this one. 

 Pivot Chart This worksheet has a PivotChart in addition to a PivotTable and a pair of 
Slicers. You will also build a PivotChart like this one. 

 Exercise This worksheet has another copy of the data. It is exactly the same as the data 
on the first sheet but, since you will be making some changes to it, I have supplied you 
with a separate set of data. 

There are 500 rows of data. Each row describes a shipment from one country to another. The year 
and month of the shipment are shown, as well as the weight of the shipment in tonnes. Also shown 
is the name of the country from which the shipment originated and the name of the destination 
country. The shipments comprise a number of different commodities, mostly grains. 

The rows of data are randomly arranged and not sorted into any specific order. This is to illustrate 
that data does not have to be organised in a particular way for analysis with a PivotTable or 
PivotChart. The only prerequisite is that the data is arranged in columns with a meaningful heading 
at the top of each column. 

http://www.fontstuff.com/training/excel/stepbystep.htm
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Create a PivotTable 

Step 2:  Go to the sheet named Exercise and select any cell in the data making sure that 
you select only one cell, then go to the Insert tab and click the PivotTable button (Fig. 
1). 

 

Fig. 1 Go to the Insert tab and click the PivotTable button. 

The Create PivotTable dialog box appears (Fig. 2) and Excel automatically selects the entire block 
of data on the sheet and enters its address in the Table/Range textbox. When working with your 
own data you should check that Excel has selected the correct data. If not, at this stage you can 
manually select the data you want to analyse or enter its address in the textbox. 

Note that the Create PivotTable dialog offers the option to Use an external data source (such as a 
different workbook or an external database). This will be the subject of different exercise. 

It also allows you to specify a location for the PivotTable, the default being a New Worksheet. If 
you wanted to create the PivotTable on a specific worksheet you would select Existing Worksheet 
(it must be an existing one because you can’t create a sheet whilst the dialog box is open). You 
would then click in the Location textbox, navigate to the appropriate sheet and select the cell 
where you wanted the PivotTable to start. 

 

Fig. 2 Accept the default settings and click the OK button. 

Step 3:  In this exercise you are going to create a PivotTable on a New Worksheet so leave 
that option selected and click the OK button. 

Excel creates a new worksheet, here named Sheet1, to the left of the Exercise sheet and adds an 
empty PivotTable to it (Fig. 3). Before starting to create the PivotTable take a look around the 
workspace. 
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Excel has added two new tabs to the ribbon under the heading PivotTable Tools. The tabs are 
labelled Options and Design. You will use these later to customise your PivotTable. The Options tab 
is selected and three buttons have been activated at its right-hand side. You will find out later what 
these buttons do. 

On the left side of the worksheet there is a rectangle containing some instructions and a diagram. 
This is where the PivotTable will be created. Note that is shows the name of the PivotTable as 
PivotTable 1. A PivotTable can be given a unique name which can be useful if it is to be 
manipulated using macro (VBA) programming or interrogated using one of Excel’s PivotTable 
functions. 

On the right side of the worksheet is the Field List. This is where you do the basic design work to 
create the PivotTable. 

 

Fig. 3 Excel creates a new worksheet containing an empty PivotTable. 

Try this: Click on any cell in the centre of the worksheet. See that the two PivotTable Tools 
tabs and the Field List have disappeared. Remember that these tools will only be shown if the 
PivotTable is selected. The text on the Pivot Table has also changed, instructing you to click it 
to start building your PivotTable so click anywhere in the rectangle to bring back the ribbon 
tabs and the Field List. 

Try this: On the Options tab click the button marked Field List to deactivate it. See that the 
Field List disappears but the PivotTable tabs remain. This button is used to hide the Field List 
when it is not needed. Click the button again to bring back the Field List. 

Step 4:  In the PivotTable Field List click the checkbox next to CountryFrom. 

This puts a tick in the checkbox and Excel places a button labelled with that field’s name in the Row 
Labels box at the bottom of the Field List. It also starts to build the PivotTable by creating a list of 
country names where the rectangle on the left of the window stood (Fig. 4). 

Excel has scanned through the CountryFrom column of the data and returned a list of all the 
unique items it found, and sorted them alphabetically. 
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Note that at the top of the list there is a cell containing the text Row Labels. The cell also contains 
a filter button. At the bottom of the list there is a cell containing the text Grand Total. 

 

Fig. 4 Excel begins to build the PivotTable 

Step 5:  In the PivotTable Field List click the checkbox next to Tonnes. 

This puts a tick in the checkbox and Excel places a button labelled with that field’s name in the 
Values box at the bottom of the Field List. It has also added a column on numbers to the PivotTable 
(Fig. 5). 

 

Fig. 5 The Tonnes field is added to the PivotTable. 

Excel deduced that the field you selected contained numerical values that it could calculate, so it 
automatically added the field to the Values part of the PivotTable. It analysed the values it found 
and summarised the data by the field that was already in the PivotTable. It labelled the new 
PivotTable column Sum of Tonnes. Each number represents the total of the Tonnes values for each 
country in the CountryFrom column of the data, and placed a grand total at the foot of the 
PivotTable column. 

Format the Numerical Data 

Unformatted numbers are hard to read so let’s add some formatting to the Tonnes field… 

Step 6:  In the Values box of the PivotTable Field List click the down-arrow on the button 
labelled Sum of Tonnes then choose Value Field Settings from the menu (Fig. 6). 

 

Fig. 6 Select Value Field Settings. 

This opens the Value Field Settings dialog box. Here you can customise the appearance of the 
selected field. You can also specify what sort of calculation is performed. You could, for example, 
choose Count so see the total number of shipments for each country, or display the Average size of 
each country’s shipments. There are several other options that we will explore later. 



Microsoft Excel 2010  Step-by-Step Pivot Tables 

©Martin Green www.fontstuff.com 5 

Step 7:  In the Custom Name textbox of the Value Field Settings dialog, change the 
field’s label to Total Tonnes. 

Step 8:  Click the Number Format button in the lower left corner of the Value Field 
Settings dialog to open the Format Cells dialog and under Category click Number. Set 
the Decimal places value to 0 and place a tick in the Use 1000 Separator checkbox 
(Fig. 7). 

 

Fig. 7 Specify a Custom Name and Number Format. 

Step 9:  Click OK to close the Format Cells dialog then click OK to close the Value Field 
Settings dialog. 

The numbers on the pivot table have now been formatted to the comma style with no decimal 
places and the field label has changed to Total Tonnes (Fig. 8). 

 

Fig. 8 Custom field settings have been applied. 

Add a Second Field 

Until now we have let Excel decide how to arrange the fields on the PivotTable, but you can easily 
place the fields exactly where you want them. 

Step 10:  Point at the Commodity field button in the PivotTable Field List and drag it into 
the Column Labels box (Fig. 9). 

 

Fig. 9 Drag the Commodity field into the Column Labels box. 

Excel has added the Commodity field to the PivotTable and created table of data in which the 
Tonnes values have been recalculated to show the Totals for each exporting Country 
(CountryFrom) by Commodity. As it did previously with the CountryFrom data, Excel has analysed 
the Commodity data and identified all the unique items, then used each one as a label for the new 
columns in the PivotTable (Fig. 10). It has also added a grand total for each row. 



Microsoft Excel 2010  Step-by-Step Pivot Tables 

©Martin Green www.fontstuff.com 6 

Note that in order to accommodate the new headings the table has moved down the sheet a little 
way. This is one of the reasons why it is a good idea when formatting PivotTable data to apply the 
formatting the field using Value Field Settings, as you did earlier, rather than simply formatting the 
cells. 

 

Fig. 10 Excel has added the Commodity field to the PivotTable. 

Note also that Excel has now placed a tick in the checkbox next to Commodity in the PivotTable 
Field List, indicating that the Commodity field is currently represented in the PivotTable. The names 
of fields included in the PivotTable are also shown in bold. 

Removing and Moving Fields 

There are two ways to remove a field from the PivotTable. 

Step 11:  Click the checkbox adjacent to Commodity in the PivotTable Field List to 
remove the tick from the box. 

As you would expect the PivotTable returns to its previous appearance as shown in Fig. 8. 

Step 12:  Click the Commodity checkbox so that it is ticked again. 

Excel restores the Commodity field to the PivotTable but this time it has decided to place it in the 
Row Labels box below the CountryFrom field. Although the same fields are being displayed in the 
PivotTable its appearance is now quite different. The calculated values from the Tonnes field are 
the same as before, just displayed in a different way. The Total Tonnes of each Commodity are 
now shown for each CountryFrom. 

 

Fig. 11 The Commodities are shown below each Country. 

Step 13:  Go back to the PivotTable Field List and in the Row Labels box drag the 
CountryFrom button downwards and drop it underneath the Commodity button. 

Again Excel rearranges the PivotTable so that the Total Tonnes of each CountryFrom are now 
shown for each Commodity (Fig. 12). These few examples are beginning to illustrate the power of 
Excel’s PivotTable tool. 
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Fig. 12 The Countries are shown below each Commodity. 

When data is shown this way it is said to be grouped. Currently (Fig. 12) the CountryFrom data is 
grouped by Commodity. Previously (Fig. 11) the Commodity data was grouped by CountryFrom. 

When data is grouped like this Excel places a small button containing a minus sign next to each 
group item. This is used to group and ungroup the field items. 

Step 14:  Click each of the minus buttons to collapse each of the Commodity groups. 

As you do this Excel recalculates the Tonnes values and displays a total for each group (Fig. 13) 
and each minus sign is replaced by a plus sign. 

 

Fig. 13 The Commodity Groups have been collapsed to show totals. 

Step 15:  Click each of the plus buttons to expand each of the Commodity groups. 

The PivotTable now shows all the data again. Here’s another way to remove a field from the 
PivotTable… 

Step 16:  In the PivotTable Field List drag the Commodity button out of the Row Labels 
box into an empty space (such as over the worksheet) so that a cross appears next to the 
mouse pointer, then release the mouse button. 

 

 

Fig. 14 Drag the Commodity button into a space. 

Conclusion 

This concludes Exercise 1. The next exercise will continue from this point so if you wish to proceed 
to the next exercise you should save the file in its current state. 
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